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1.        Einleitung

Auf den nächsten Seiten wird eine kurze Einführung in P-CAD gegeben.

Die Einführung soll und kann nicht Handbücher und erfahrene, auskunftsbereite Anwender ersetzen, sondern lediglich als kleine Hilfe für Anfänger und als Auffrischung dienen.

Um die Rolle, die P- CAD bei der Printherstellung spielt zu erklären, wird etwas kurzes zum Werdegang eines Prints gesagt.

1.1          Die Printherstellung

Die Printherstellung gliedert sich in die folgenden Abschnitte, bei denen das Arbeiten mit P-CAD eine grosse Rolle spielt.

Arbeitsschritte bei der Printherstellung:

· Schaltung entwickeln

· Schema zeichnen (P- CAD Schematic)

· Layout (engl. für Plan) erstellen, auch routen genannt (vom engl. to route, führen) (P-CAD PCB)

· Ausdruck erstellen (dient als Negativ beim Print belichten)

· Print belichten

· Print entwickeln

· Print ätzen und evtl. mit Abreibsilber behandeln

1.2          Zum P-CAD:

Wie der Name schon sagt, handelt es sich bei P-CAD um ein CAD- Programm

(Computer Aided Design). Wie von den CAD- Programmen gewohnt, helfen sie dem Anwender, Arbeitsabläufe zu erleichtern und  zu automatisieren, so auch P- CAD.

P- CAD besteht aus diversen Programmteilen, das Arbeiten mit den wichtigsten Programmteilen wird kurz beschrieben.

  PRINTLAYOUT MIT P- CAD

Bevor mit einem neuen Projekt auf P-CAD begonnen werden kann, muss eine sogenannte Library (engl. für Bibliothek) erstellt werden. 

Dieser Schritt ist nötig, weil sich nicht alle möglichen Bauelemente in der Standard Library befinden können, da laufend neue Typen von ICs usw. dazukommen. Auch dienen Projekteigene Libraries zur besseren Übersicht und sind einfacher zu verwalten.

Alle Komponenten benötigen ein Symbol und ein Pattern (engl. für Form)  im P- CAD, damit sie im Schema und vor allem im Layout dargestellt werden können.

Das Erstellen, Zusammenstellen und Verwalten der Komponenten wird mit Hilfe des Programmteils Library Executive gemacht. => vom Schematics oder PCB :Utils, 

P-Cad Library Executive. 

2.        Die Library Executive

2.1          Die Oberfläche der Library ExecutiveDIE OBERFLÄCHE DER LIBRARY EXECUTIVE
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2.2          Arbeiten mit der Library Executive

Dies ist Anfangs ein etwas schwieriges unterfangen, hat das Programm doch seine Eigenheiten die man kennen sollte.

Einige wichtige Arbeitsschritte:

2.2.1       Eine Neue Library erstellen

Zu erst wird das Programm „Library Executive“ gestartet. Es befindet sich im Startmenü unter Programme, P-CAD Library Executive.
Mit einem Klick auf Library, New wird das Fenster zum Speichern einer neuen Library geöffnet.. Nun die Library mit einem, zum neuen Projekt passenden Namen benennen.

Jetzt haben wir also sozusagen den Ordner vom Typ.lib (Library). Wie allgemein bei Ordnern üblich, wollen diese gefüllt werden. Hier führen 2 Wege zum Ziel: entweder kopiert man Komponenten aus bereits existierenden Libraries oder erstellt diese selber. 

2.2.2       Komponenten kopieren:

Falls schon eine Library mit den benötigten Komponenten vorhanden ist (das ist häufig der Fall), man jedoch nicht drum herum kommt, eine Neue zu erstellen (das kann verschiedene Gründe haben, z.B. ist eine bessere Übersicht im ganzen Projekt garantiert), ist es wichtig, dass man den „Copy- Befehl“ zum Komponenten kopieren kennt.

Um also eine Komponente samt Anhang (Symbol, Pattern) aus einer Library zu kopieren muss folgendermassen vorgegangen werden:
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Library  => Copy, wobei sich ein Fenster öffnet:
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2.2.3       Eine Komponente erstellen

Oft ist es nötig, eine Komponente zu erstellen, da sie entweder neu oder nirgends zu finden ist.

Eine Komponente beinhaltet ein Symbol und ein Pattern.

Man fängt am besten beim Symbol an. Der Grund lässt sich einfach erklären: Nämlich kann man beim abspeichern des Symbols die Option „Create Component“ auswählen, durch das man sich einige Arbeitsschritte, wie das separate Erstellen einer Komponente und das Zuweisen (letzteres wird noch erklärt) eines Symbols sparen kann.

2.2.3.1    Ein Symbol erstellen

Zuerst muss der Symbol- Editor geöffnet werden. Da in aller Regel noch einiges mit dem Symbol gemacht werden muss (Zuweisen usw.), tut man dies am besten von der Library Executive aus (der andere Weg ginge über das Windows- Startmenü, Programme, P- CAD, Symbol Editor).

Es wird also auf das Symbol- Menü in der Menüleiste der Library Executive geklickt. Dann den Unterpunkt „New“ auswählen. Folgendes Fenster öffnet sich:

(es kann auch ein anderes Symbol zu Beginn gezeigt werden)
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Nach diesen „Grobeinstellungen“ Klick man auf den „Finish“ Button (siehe Grafik) und erstellt das Symbol zu Ende, d.h. diverse Änderungen können weiterhin vorgenommen werden. Dabei darf der „Ref- Point“ (Referenzpunkt) und das „Ref Des“ nicht vergessen werden: -> Symbole am linken Bildrand. Ref-point an einem Anschluss, Ref-Des uebers Bauteil platzieren.

                              Nun soll das ganze gespeichert werden: (Beachte Information im Textfeld)
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Nun ist die Komponente mit dem Symbol (das Pattern fehlt noch) in der Library vorhanden aber in der Library Executive noch nicht zu sehen. Deshalb muss diese Aktuelle Library durch Rechtsklick auf deren Namen, -> Remove entfernt werden und auch gleich wieder zugefügt werden. Das Hinzufügen wird durch einen Rechtsklick auf DEFAULT_LIBRARY_SET -> Add Library (die entfernte Library wieder auswählen) gemacht. Dies ist nötig, da sich das Programm nicht von selbst aktualisiert.

2.2.3.2    Ein Pattern erstellen

Nun muss der Komponente noch ein Pattern zugefügt werden. Bevor das getan werden kann, muss auch das zuerst erstellt werden.

Man geht nach dem schon vom Symbol erstellen bekannten Weg vor: In der Library Executive Klick auf das Pattern Menü, dort den Unterpunkt New wählen.

Auch hier öffnet sich wieder ein Fenster das zuerst auch einen Vorschlag anzeigt. 

Entweder man klickt gleich auf Finish und löscht ihn dann, oder er ist brauchbar, und muss nur noch wenige Parameter ändern.

Danach kann (nach dem Klick auf Finish) im Pattern Editor weitergearbeitet werden:

(Beachte Information im Textfeld)


Nun ist die Komponente mit dem Symbol und dem Pattern in der Library vorhanden, aber in der Library Executive noch nicht zu sehen. Deshalb muss diese Aktuelle Library durch Rechtsklick auf deren Namen, -> Remove entfernt werden und auch gleich wieder zugefügt werden. Das Hinzufügen wird durch einen Rechtsklick auf DEFAULT_LIBRARY_SET -> Add Library (die entfernte Library wieder auswählen) gemacht. Dies ist nötig, da sich das Programm nicht von selbst aktualisiert.

2.2.3.3    Komponente mit dem Symbol und dem Pattern verbinden

Wir müssen jetzt nur noch das Pattern der Komponente zuführen (das Symbol ist bereits vorhanden in der Komponente).

Doppelklick  auf den Komponenten- Namen, wobei sich ein neues Fenster öffnet, die sogenannte Component Information des jeweiligen Bauteils:
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Das Fenster schliessen und die Änderungen speichern indem die Component noch mal durch doppelklicken angewählt wird. Die Dialogbox „Save changes...“ durch OK bestätigen.

Vielleicht muss die Library nochmals aktualisiert werden (entfernen, wieder zuführen, wie bereits erwähnt).

Ansonsten ist jetzt ein weiteres Bauteil der Library hinzugefügt worden.

Diese wenigen Schritte sind glücklicherweise schnell erlernt, da sie bei jeder neuen Komponente, die im P- CAD benötigt wird, zu wiederholen sind.

3.        Schema erstellen
 Ein Schema wird mit Hilfe des Programmteils „Schematic“ erstellt. Auf dem Schema sind alle Anschlüsse und Teile ersichtlich. Ein Schema hilft, eine Schaltung zu verstehen, sie überhaupt bildhaft zu machen.

Schemas könnten problemlos von Hand gezeichnet werden, jedoch gelingt dies auf  P- CAD sicher besser, ausserdem ist das Schema nützlich beim erstellen des Layouts. Es kann nämlich vom Schematic (der Name des Programms, welches zur Schemazeichnung verwendet wird) aus eine sogenannte Netlist erstellt werden. Sie enthält alle Verbindungen des Schemas. Diese können dann ins Layout Programm geladen werden. Die Bauteile werden also selbständig, mit allen Verbindungen vom Programm geladen. 

Alles was dann noch getan werden muss, ist das Plazieren der Bauteile und deren Verbindungsleitungen.

Doch nun zum Schematics:

Mit Hilfe von Schematics wird also die Schaltung „auf Papier gebracht“. Die Bedienung des Programms gestaltet sich recht einfach, die wenigen Anweisungen im Textfeld neben der Grafik sollten genügen, um ein einfaches Schema erstellen zu können. Den Rest lernt man am Besten mit viel Übung

Ist das Schema erst mal fertiggestellt, muss es weiterverarbeitet werden können.

Deshalb wird eine sogenannte Netzliste erstellt. Dies ist nötig, weil Dateien die mit Schematic erzeugt werden nicht im PCB gelesen werden können. Man braucht also eine „universelle Sprache“, das ist die Netzliste. Sie teilt dem Programm nur mit, wie die Komponenten untereinander verbunden sind. Im PCB werden dann statt den Symbols die Patterns geladen, da es im PCB ums Printlayout geht.

3.1          Netzliste erstellen:

· Utils -> generate Netlist. Folgendes Optionsfeld erscheint:


Die Arbeit mit Schematics ist nun getan, wir können das Schema wie mit dem üblichen Speicherdialog speichern.

Eventuell wäre auch ein Ausdruck des Schemas sinnvoll.

Im P-CAD sind zwei Druckerdialoge vorhanden. Der Windows- Standard (Print Setup) Dialog und der P-CAD Dialog (Print, beide Dialoge unter dem Menüpunkt „File“). Letzterer wird empfohlen, da mit dem Windows- Standard Dialog gar nicht gedruckt werden kann, sondern nur wenige Einstellungen vorgenommen werden können.

Am besten ist es also, man stellt alles beim P-CAD Print- Dialog ein.

Tipp: um vom Hochformat zum Querformat zu wechseln, die Funktion „Rotate“ anwählen.

„generate Printout“ und Schematics druckt!

4.        Layout erstellen

Nun öffnen wir das Layoutprogramm  PCB.

Dort wird als erstes, wie schon zuvor erwähnt, die Library geladen.

Erst dann kann die Netlist ohne Fehlermeldung geladen werden:

· Utils, Load Netlist.

Das erscheinende Optionsfeld sollte folgendermassen aussehen:
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Sobald dann alles richtig platziert und verbunden ist, könnte das Layout so aussehen:
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Ob alles richtig verbunden ist und den richtigen minimal Abstand einhält, können wir durch das Programm prüfen lassen. Diese Funktion wird durch den DRC (Design Rule Check) zur Verfügung gestellt.

· Utils-> DRC.  Ein neues Fenster öffnet sich:



Wichtig hierbei ist, dass man die Design-Vorgaben überprüft. Dazu wählt man diese aus, wobei sich ein neues Fenster öffnet...:


Dann wird das DRC- Fenster wieder geschlossen, bevor automatisch ein Fenster erscheint, in welchem man den Pfad der Netlist- Datei angeben muss.

Danach erscheint ein Notepad- Outputfile, in welchem alle gefundenen Fehler angezeigt sind.

Ausserdem werden sie auch im Layout durch hellblaue Kreise angezeigt. Dazu muss jedoch unter dem Optionsfenster des DRC bei Error Options „Anotate Errors“ angewählt werden.

Durch einen Doppelklick auf einen solchen Kreis erhält man nähere Angaben zum Fehler. Diese sollten dann nach und nach beseitigt werden. Wenn es auch zum Teil eine Mühsame Angelegenheit ist, sollte ihr nachgegangen werden. Es ist immer noch 

einfacher, als wenn man später beim Printätzen die nötigen Abstände nicht hin bringt, weil sie zu schmal gewählt wurden.

Sind dann alle Fehler beseitigt, muss das ganze noch gedruckt werden.

Dazu wird unter ->File -> Print -> Setup Print Job gewählt, wo im oberen Teil ein neuer Printjob benannt werden kann.


Sobald dann alles richtig und fehlerlos auf Papier ist, können wir auch das PCB, nach abschliessendem speichern, wieder schliessen.

Die Arbeit mit P-CAD wäre nun getan, der Print muss nur noch geätzt werden.

Dazu muss das Layout auf Klarsichtfolie gedruckt werden, damit eine Printplatte belichtet werden kann.

Dabei sollte beachtet werden, dass die Unterseite (Bottom) des Print gespiegelt werden. Dazu muss die Funktion „Mirror“ im Printdialog angewählt werden.

Dann kann das Layout ausgedruckt werden.

5.        Anhang 

5.1          Die Printherstellung

Nachdem also das Layout auf Folie aufgedruckt wurde, müssen die beiden Folien (Top und Bottom) genau aufeinander gelegt werden. (siehe Skizze)



Das genaue aufeinanderlegen ist sehr wichtig, da sonst die Via’s nicht aufeinanderpassen.

Das neue, leere Printmaterial, dem die Schutzfolie abgezogen wurde, legt man nun zwischen die beiden Folien (siehe Skizze oben).

Danach wird der Print mit UV- Licht belichtet. Dies dauert wenige Minuten, beim Belichtungsautomat auf die 2 Stufe stellen.

Danach wird der Print an einem Printhalter befestigt, um ihn in das Entwicklerbad, das im wesentlichen aus Natronlauge besteht zu hängen.

Danach, nach etwa 6 Minuten Entwicklungszeit wird der Print kurz mit Wasser abgewaschen, bevor man ihn für längere Zeit, das heisst bis alles Unnötige weggeätzt ist, ins Ätzbad (besteht aus EisenIII-chlorid) hängt.

Mit einem guten Ätzbad dauert das Wegätzen ca. 5-7 Minuten, nach häufigem Gebrauch des Bades steigt die Zeit bis zu 15 Minuten. Diese Angaben sind jedoch herstellerabhängig. 

Während dem ätzen sollte der Print hin und wieder abgewaschen werden, so auch wenn der Ätzvorgang abgeschlossen ist. Dies ist der Fall, wenn nach eigenem kritischen Beurteilen alle Leiterbahnen freiliegen und somit keine Nichtgewollten Verbindungen mehr bestehen.

Der Print kann anschliessend noch mit Abreibsilber behandelt werden.

Dies sollte vorsichtig gehandhabt werden. Am besten Schutzbrille und Gummihandschuhe tragen.

Das Abreibsilber wird in geringen Mengen mit Papiertüchern aufgenommen und auf den Print regelmässig und grosszügig aufgetragen

Nach gründlichem reinigen mit Aceton und anschliessendem bohren der Via’s ist die Herstellung des Prints abgeschlossen.

Er kann nun, nachdem die Durchkontaktierungen vorgenommen wurden (die Via’s beider Seiten müssen verbunden werden) bestückt werden.

Damit wären wir zu Ende mit dieser kleinen Einführung in die Printherstellung und vor allem in das Printlayout.

5.2          Links:

http://www.pcad.com/
die Herstellerseite von P-CAD

http://www.pcad.com/en/library/library_list.asp
Library Downloads

http://www.pcad.com/en/support/tutorial_home.html
ausführliche Tutorials

Hier sieht man die verschiedenen geladene Libraries








Diese Libraries sind unterteilt in Components, Patterns und Symbols.


Die Component beinhaltet sozusagen die Patterns und die Symbols und ist somit wie ein Gerüst. Einstellungen wie die Zuordnung der Patterns und Symbols, die Pinbelegung usw. werden unter Components vorgenommen.


Patterns (dt. Form)


Patterns stellen sozusagen den Grundriss (die Form) des Symbols dar, und werden  deshalb im PCB (Layout- Programm) benötigt.


Symbols werden  für das Schemazeichnen benötigt.


Sie enthalten den Namen, Wert und die Anschlussbelegung des Bauteils.











Sobald das neue Symbol gezeichnet ist, kann beim abspeichern (Save as) gleich eine Komponente mit erzeugt werden. Dazu müssen die beiden Optionsfelder angewählt werden! (Richtigen Librarynamen verwenden).


Ausserdem sollte ein zutreffender und zuordbarer Name fuer das Bauteil gefunden werden.





Evtl. Erscheint noch eine Fehler- Meldung: “Proceeding will lose existing pin designator, do you wish to continue?


Diese kann man mit OK bestätigen.





Darauf erscheint nochmals ein Fenster 


„Save Component as“ dort den gewünschten Speichernamen eingeben,  Component Type: Standard.








Als erstes nach dem Programmstart sollte die Library geladen werden:


Library -> Setup -> Add:


Jetzt sollte die zuvor erstellte Library hinzugefügt werden (dieser Schritt ist später im PCB zu wiederholen!).





Dann kann mit dem Schema begonnen werden:


Um eine Komponente zu platzieren, muss diese erst ausgewählt werden: -> Place -> Part (jetzt Komponente auswählen und mit Linksklick platzieren, Rechtsklick wieder abwählen).


Die Komponenten müssen untereinander verbunden werden:


„Place Wire“  2 (oberstes Symbol in der linken Werkzeugpalette), dann auf des Symbols Anschluss klicken um eine verbindende Linie zum anderen Symbol ziehen (wieder auf dessen Anschluss).





Zuvor sollte allerdings noch der Zeichnungskopf eingefügt werden, welcher unter DocTools -> Titles -> Fields verändert werden kann. 


Wichtige Daten sind: Datum, Name des Erstellers, Versionsnummer und natürlich der Projektname samt Titel des Prints.





Mit Ausnahme des Speicherortes (kann mit Klick auf Netlist Filename- Button geändert werden) sollte das Optionsfeld wie das angezeigte aussehen.


Mit Klick auf OK bestätigen.





Bei Netlist Filename sollte der Ablageort des zuvor erzeugten Netlist- File angegeben werden. Das Format muss dasselbe wie beim erzeugen sein und zwar generell P-CAD ASCII.


Bestätigen mit OK.











Was nun erscheint ist ein ziemliches Wirwar aus Patterns  (entsprechen den Symbolen im Schematics) und Verbindungslinien. 


Dies muss geordnet werden.





Ein Print Aussenrahmen muss erstellt werden. Das kann im PCB  mit Hilfe der Funktion Place Line (in der linken Werkzeugpalette zu sehen.) gemacht werden 





Die Bauteile sollen nun so angeordnet werden, dass sich keine Linien überschneiden werden, die Minimalbreite der Linien von 0.6mm ausreicht (vorausgesetzt, es wird selber geätzt) und der Minimalabstand zwischen Leitern von 0.3mm nicht unterschritten wird.





Um das zu erreichen sind einige kleine Tipps angebracht:





- Möglichst viele 45° Winkel (statt 90° ) bei Richtungswechsel anwenden, braucht weniger Platz und sieht besser aus (andere Winkel sind „verboten“).





Ober- und Unterseite ausnutzen! Um ein Bauteil nach Unten zu „verbannen“ muss die Taste F (Flip= umdrehen) gedrückt werden.


Um Leiterbahnen von Unten nach Oben zu verbinden werden sogenannte Vias gesetzt -> Options -> Via- Style (dort können Änderungen (zuerst aber den Default- Type kopieren und umbenennen)  vorgenommen werden (Modify Simple). Minimaler Aussendurchmesser ca. 1.4mm, Innendurchmesser ca. 0.5mm.





         -       Um zwischen der Ober- und Unterseite (Top und Bottom-Side) zu wechseln, muss nur     da gewechselt werden. Je nachdem was 


                 gewählt ist steht Botom oder Top im Vordergrund. Um eine Seite vollständig auszublenden, kann das unter ->Options-> Layers getan 


                 werden. Es erscheint wieder ein Auswahlfenster.    (siehe Grafik und Text unten)                                                    Layer= Ebene








                     

















Hier können die verschiedenen Layer an, bzw. Abgewählt werden.


Zuerst sollte aber der „Current Layer“ (aktueller Layer) gewählt werden, da zum Beispiel nicht der Aktuelle Layer unten abgewählt werden kann!





Um einen Layer an, bzw.  Anzuwählen, wird dieser markiert und durch Enable angewählt, und mit Disable abgewählt. Ausserdem kann die Funktion Enable/ Disable All gewählt werden.











Groundfläche





Groundfläche





Via








Anschlusspads





Hier wird der Filename angegeben





Einstellen der Design Regeln








Diese Einstellung ist besonders wichtig: Hier wird dem Programm gesagt, welche Abstände die Minimalen sind. Die anderen Einstellungen kann man sicher bei einfachen Prints beiseite lassen.





Je nach Seite die gedruckt werden soll (normal nur Top und Bottom- Side) werden andere Display Options gewählt. 





So sind die im Bild zu sehenden für die Top- Side, während die Bottom –Side  die selben Display- Options hat, um die Mirror – Auswahl (spiegeln) erweitert.


Die Rotate- Auswahl ist dafür da, dass der Ausdruck im Querformat zustande kommt.





Um das Drucken zu starten, auf Generate Printouts klicken.





Links: Der Pattern Editor.


Er ist einem CAD- Programm teilweise sehr ähnlich, übernimmt im P-CAD auch diese Funktion.





Das Zeichnen eines neuen Pattern stellt kein grosses Problem dar und bedarf an dieser Stelle keiner weiteren Erklärungen.





Was dennoch nötig ist zu sagen:


- Die Abmasse entnimmt man am besten einem Datenblatt, oder, falls das nicht möglich ist, durch nachmessen am Bauteil. 


Korrekte Masse sind verständlicherweise sehr wichtig.





- Im P-CAD kann eigentlich jedes beliebige Gitter eingestellt werden, jedoch kann es zu Problemen führen, wenn in den verschiedenen Programmteile unterschiedliche Gitter benutzt werden. Also am besten sich auf ein bis zwei, ineinander überführbare Gitter festlegen.





- „Ref- Point“ (Referenzpunkt) nicht vergessen





Source- Library: hier wird die Quell- Library angegeben





Destination Library: hier wird die Ziel- Library angegeben.





Button „Browse to Add” : hier wird das genaue Bauteil (Komponente) ausgewählt.





Die Vielzahl an Möglichkeiten im P-CAD macht das arbeiten nicht immer leichter: Alles muss einzeln kopiert werden: Component, Pattern und Symbol (also für alle 3 den Kopiervorgang durchführen).





Mit Klick auf den Copy- Button wird der Vorgang bestätigt.





Nachdem alle 3 Teile kopiert worden sind,  sind  sie in der Library vorhanden aber im Library Executive noch nicht zu sehen. Deshalb muss diese Aktuelle Library (die, welche unter Destination Library angegeben wurde) durch Rechtsklick, -> Remove entfernt werden und auch gleich wieder zugefügt werden. Das Hinzufügen wird durch einen Rechtsklick auf DEFAULT_LIBRARY_SET -> Add Library (die entfernte Library wieder auswählen) gemacht.











Links: In diesem Fenster wird das Symbol und das Pattern der Komponente zugeordnet.





Bei Reif- Des Präfix wird ein Abkürzungszeichen eingesetzt, z.B. ein Widerstand hat das Präfix R





Hauptfenster








Das vom P- CAD vorgeschlagene Symbol


(kein Einfluss vom Anwender)





Auf dieser Seite lassen sich einige grobe Voreinstellungen, wie z.B. die Pin- Anzahl, Länge und Breite des Symbols usw. vornehmen.





FINISH BUTTON





Das vom P- CAD vorgeschlagene Pattern


(kein Einfluss vom Anwender)





Auf dieser Seite lassen sich einige grobe Voreinstellungen, wie z.B. Die Pad- Anzahl, Länge und Breite des Patterns usw. vornehmen.





FINISH BUTTON





Menüleiste





Die Schematics Oberfläche








Zeichnungskopf





Schema





Die PCB- Arbeitsfläche mit einer geladenen Netlist.


 PCB ordnet nur auf verlangen die Teile an, jedoch nicht sehr überzeugend.





Folie





Top und Bottom





Distanzhalter aus altem Printmaterial





P-CAD Bedienungsanleitung
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